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Woord vooraf

Het maken van digitale foto’s is een fluitje van een cent. Maar wat moet je nu verder met al
die foto’s? Wat doe je wanneer je wel een leuke foto hebt, maar waarbij eigenlijk nog iets
gecorrigeerd zou moeten worden? Of je wilt er maar een stukje van gebruiken?

Deze praktische cursus ‘Fotobewerking voor beginners’ biedt de oplossing. Er zijn
diverse(gratis) programma’s waarmee het gemakkelijk is om foto’s op eenvoudige manier te
bewerken en te gebruiken voor diverse doeleinden.

In deze cursus gaan we aan de slag met het programma IrfanView. Dit is een klein, gratis
programma waarmee je snel een aantal veel gebruikte aanpassingen en verbeteringen op
foto's aanbrengt. IrfanView is snel en multifunctioneel. Je kunt afbeeldingen bekijken en
bewerken: je kunt foto's vergroten, verkleinen, roteren, kleurcorrectie en filters toepassen,
enzovoort. Ook is IrffanView heel geschikt om slideshows (diavoorstellingen) en screenshots
(schermafbeeldingen) mee te maken; bovendien kun je er filmpjes mee afspelen.

Je leert hoe je het programma kunt downloaden en installeren en met oefenfoto’s ga je aan
de slag met verschillende fotobewerkingen.

Wij vertrouwen dat je met behulp van deze cursus de eerste beginselen van het
bewerken en creatief bezig zijn met digitale foto’s snel onder de knie krijgt. Wees niet
bang om veel te experimenteren, daarmee krijg je het programma het beste onder de
knie. Zorg wel altijd voor een goede back-up!

Wij wensen je hierbij veel succes en plezier.

SeniorWeb Nijkerk
Voorjaar 2017



1 Downloaden

Tip: alvorens een nieuw programma te installeren, is het altijd verstandig om een herstelpunt
te maken. Dit doe je via het Configuratiescherm > Systeemeigenschappen.

Het programma IrfanView is gratis te downloaden. Oorspronkelijk was het Engelstalig, maar

je kunt bestanden downloaden om het programma Nederlands te maken.

onderstaande stappen kun je het programma downloaden en installeren.

Klik boven aan deze pagina op de knop Downloaden.

Aan de hand van

Ga naar www.seniorweb.nl/software/irfanview. Klik op de knop Download.

De website Download.com opent. Deze pagina is betrouwbaar, het is de plek waar de

maker van IrffanView het programma zelf aanbiedt. Klik op die site op de groene knop

met de tekst Download now.

Home » Windows Software » Digital Photo Software » Photo Editors » Irf ]

* IrfanView

Download Now

Let op: Afhankelijk van het besturingssysteem kunnen afbeeldingen

het programma wilt doen.

er anders uitzien!

Klik op Download Now. Er wordt een nieuw scherm geopend, met de vraag wat je met

Watch: How To Install Your Download

EXPLORE FURTHER

All About Microsoft Offid

All About Microsoft Offl

» Moblle
+ Hide Vpn
> SuperVpn
Opening iviewddd_setup.exe b
You have chosen te open:
0] ivieweddd_setup.exe
which is: Binary File (2.1 MB)
from: https//files. downboadnow.com
More Products to Consider Woukd you Rbe o cavy thic fa?
) =]
- PhaotoScans | pownioan | il lbvevrsw o sxvsseanny
e Kilik op Save File (Opslaan). Nu wordt het installatie-programma opg

Downloads.

¢ Het kan zijn dat daarna de volgende balk onderin beeld verschijnt:

eslagen in de map

Downloaden van iview444 x64_setup.exe is voltooid. Uitvoeren Map openen

Downloads weergeven *

Klik in dat geval op Uitvoeren.
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http://www.seniorweb.nl/software/irfanview

e Komt deze balk niet in beeld, ga dan naar de map Downloads en dubbelklik op

iview444 setup.exe.

‘ % viewddd setup.exe 22-12-2016 09:55 Toepassing 2,108 kB
* Erwordt gevraagd of je o} IrfanView 32-bit Setup X
toestemming geeft dat dit
programma veranderingen
aanbrengt. Klik op Ja. Dan #l:h‘fﬂll'l'inlul Welcome to IrfanView setup!
verschijnt het volgende
scherm, waarin je onder - N _ o
andere bepaalt of er een is program will install IfanView version 4.44 (32-bit) on your system.
shelkoppeling op het B
Bureaublad moeten komen
en of het programma in het [ Create IfanView shortcut l:fn the Desktop
[JCreate IfanView Thumbnails shorteut on the Desktop Uncheck all
?tt:;tnmenu moet komen te [ Create IfanView shorteut in Start Menu Programs
o Laat het bovenste vinkje g:: curent serorly
staan; hiermee wordt een
snelkoppeling op het Installation folder:
Bureaublad geplaatst. : S :
Laat ook het rondje staan C:A\Program Files gc86)\fanView' Browse
voor ‘For current user only’
en kllk Op Volgende. Read IfanView EULA (End User License Agreement).
e Nu komt er een scherm met
notities over wat er allemaal Vorige Bt
nieuw is in het programma.
Klik weer op Volgende.
e In het nieuwe scherm 3 rfanView 32-b7 Setup %
bepaal je welke
beeldbestanden aan Do you wart to associate extensions with IfanView? (optional ')
IrfvanView gekoppeld -
worden. Dat houdt in dat als L] AN Animated Windows Cursors
je een bepaalde afbeelding (] 83D BodyPaint 30 Format
opent, bijvoorbeeld een foto ngmm :';"”.d”ws Bimep )
asio Camera Format (JPG only)
in jpg, dat de foto dan met ] cLp Windows Clipboard
dit programma wordt ] CRW/CR2 Canon RAW Fommat *
geopend. In onze cursussen Sgg;mmm g’lzgﬂh;";C”f:tﬂj
werken we alt”d via de . [Jocx Multipageogoﬂ Paintbrush
verkenner, dus moet er hier (] oDS Direct Draw Surfacs *
niets worden aangevinkt. [ DJvu/wA4 DiVu Format *
Klik op V0|gende. [J oxrF Drawing Interchange Format * .
+ Er wordt aangegeven in Do e
welke map het programma 1 FPs/Ps Post Serint Fomat * v
standaard wordt Info: i you are just updating an older version, you can leave all boxes unchecked
geinstalleerd. Laat dit zo
staan en klik op Volgende. | -Plugins Select al None
< Vorige Volgende > Exit
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e Het programma wordt ) IfanView 32-bit Setup X
geinstalleerd en vervolgens

komt de melding dat dit
. i ]
succesvol is verlopen. Installation successful! *h’fﬂﬂrlﬂllll
° Zet de twee Vinkjes uit en Setup has finished installing this program on your computer.
klik op Done.

e Hiermee is de Engelstalige
versie geinstalleerd.

What to do next?
[]Open IfanView FAQs homepage
[ Start IfanView

How to uninstall IfanView?

Go to "Stat->Programs-=IfanView" and click the "Uninstall IfanView" item.

2 Nederlandse vertaling

Om IrfanView Nederlands te maken, moet je een taalbestand downloaden en installeren.
Sluit eerst IrfanView af als je het programma per ongeluk toch geopend hebt.

Als je de website van Seniorweb.nl nog open hebt staan, kun je bij Stap 2 bij punt 2 klikken
op ‘hier’, je wordt dan doorgelinkt naar:

http://lwww.irfanview.net/lang/irfanview _lang_nederlands.exe

Dan komt de volgende melding in beeld:

Wat wilt u doen met irfanview_lang_nederlands.exe (204 kB)?

) i Opslaan Opslaan als Annuleren X
Van: irfanview.net p P

¢ Kilik op Opslaan; het bestand wordt geplaatst in de map Downloads.

¢ Dan komt de melding dat het downloaden is voltooid; klik nu op Uitvoeren.

e Afhankelijk van het
besturingssysteem kan het
ook hier zijn dat de You have chosen to open:
schermen er iets anders
uitzien, bijvoorbeeld als

Opening irfanview_lang_nederlands.exe x

IE| irfanview_lang_nederlands.exe

hiernaast afgebeeld. which is: Binary File (203 KB)
e Klik op Save File. Het SiamEibe v Samics et
bestand wordt in de map Would you like to save this file?

wnl [ ) -
downloads geplaatst S

SeniorWeb Nijkerk — 2017-1
Fotobewerking voor beginners Pagina 7 van 36



Ga via de Verkenner naar de map Downloads toe en start het programma door er dubbel
op te klikken.

Let op: In een aantal versies van Windows verandert het scherm en zie je een klein
venster in het midden. Daarin Kklik je op Ja om toestemming te geven voor installatie.
Mocht je een waarschuwing krijgen van het antivirusprogramma, dan kun je deze
negeren. Komt er een waarschuwing van Windows, klik dan op Meer informatie > Toch
uitvoeren.

De installatie van het taalbestand gaat verder. Klik op Install.

,_%1 IrfanView Language Installer 4
*lrfﬂﬂwem Welcome to IrfanView Language Installer!

This program will install additional IfanView language on your system.

Destination folder must be your IffanView folder.

Language: NEDERLANDS Version: 440

Destination folder:
|C:\Program Files (xB6)\lrfanView\ || Browse

Install Cancel

Dan verschijnt het eindscherm waarbij meegedeeld wordt dat de installatie met succes is
afgerond. Klik op OK

IrfanView Language Installer >

o Installation successfull!

0K

Start IrfanView via het pictogram op het Bureaublad of via het Startmenu.
Klik op het menu Options > Change language.

Klik in het rechtergedeelte op Nederlands.dll.

Klik links op OK.

IrfanView is nu in het Nederlands omgezet.

Let op! Bij de installatie kan het zijn dat je de vraag krijgt of je Amazon Button App (of
Google Toolbar of Google Chrome) ook wilt installeren. Als je dat niet wilt moet je die opties
uitzetten, door de vinkjes weg te halen!

Er zijn diverse instellingen die je in IrfanView naar eigen wens kunt aanpassen. Zie hiervoor
de bijlage achterin het boek.
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3 Plug-ins

IrfanView beschikt ook over diverse plug-ins, waarmee je nog meer functies in het
programma tot je beschikking krijgt. Daarbij moet je wel letten op je besturingssysteem: is dit
32- of 64-bit. Niet alle plug-ins zijn geschikt voor de 64-bit versie. De plug-ins kunnen worden
gedownload via een website voor het downloaden van gratis software:
https://www.gratissoftwaresite.nl/downloads/irfanview-fotobewerking-viewer-batch-conversie
In dit artikel staan de links naar diverse plug-ins:

e Download IrfanView 32-bit Plug-ins via MajorGeeks
e Download IrfanView 64-bit Plug-ins via MajorGeeks

Ga naar deze website en klik op de link die voor jouw besturingssysteem geschikt is.

< HOME | UPOATER | MAC | ANOROLID APP| NEWSLETTER] DEALST| SUPPORT FORUM |

MAJOR GEERS

WG Use of T 06 My CHBE YOu 1O GRcesbvely Sownioad 0ol programa and feel geesy

MajorGeeks. Com » Graphics » Viewers » IrfanView Plogins 4.44 « Downdoad Now

IrfanView Plugins 4.44 OFFICIAL NIRROR.

Author: &1 ki - Rating: & (209 vates)

Date: 12/21/2016 07:40 AM ¥ DownloadOMajorGeehs I — e

Stre: 15.4 M0 ¥ Download O MajorGeeks J

License: Freaware n m .
Cavart Opa Requires: Win 30/ 8/ 7/ Vata / X o L &
Ortwve (Ml ies (OO, Downloads: 444094 s Repart & Bad Lmh

WS, OV0) lo Comments @ Screenshots,

Klik vervolgens op Download @MajorGreeks. Onderstaand scherm wordt geopend.

Opening irfanview_plugins. 444, setup.exe w | Klik op Save File. Het bestand staat
dan in de map Downloads.
Dubbelklik in de map downloads op

You have chosen to open:

[ irfanview_plugins_444_setup.exe irfanview_Plug-ins_444 setup.exe.
which is: Binary File (15,5 MB) Let op: In een aantal versies van
from: http://files2.majorgeeks.com Windows verandert het scherm en zie
Would you like to save this file? je een klein venster in het midden.
Daarin klik je op Ja om toestemming
Save Fil C | . .
ETE te geven voor installatie.
&) IfanView Pluglns 32-bit Setup b

Vervolgens komt het scherm in beeld

e [rfanli | _ waar wordt aangegeven in welke map
ITAVEW|  wWelcome to IrfanView Plugins setup! de plug-ins worden geplaatst.
Klik op Volgende

This program will install additional IfanView Plugins version 444 (32 bit) on your system. ) .
Onderstaande melding verschijnt.

Destination folder must be your (base) Ifan'iew folder. IfanView F'Iuglns. 32-hit SEtLIFI Y

If the installer cant find IfanView-32 in the system registry, please use the ‘Browse” button
and find it manually.
(Do NOT install these Pluglns to IfanView 64-bit folder)

Diestination folder: o Installation successfulll

| *Program Files {xB&)\danView | Browse

Pressthe "Volgende =" button to start the installation ..

OK

<Vorige Ext Klik op OK.

SeniorWeb Nijkerk — 2017-1
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4 Aan de slag

Dubbelklik op het icoon op het bureaublad. Het programma wordt geopend en onderstaand
scherm komt in beeld.

# IrfanView - ] *

Bestand Bewerken Afbeelding Opties Weergave Help

FEEReX| {329 0 RQeEs R EXY

Openingsscherm
IrfanView

Geen bestand geladen (gebruik Bestand -> Openen menu)

Klik op Bestand > Openen.

Blader naar de locatie waar de foto die je wilt bewerken zich bevindt.

Klik op de foto die je wilt openen.

e Klik op Openen.

In deze cursus werken we met foto’s die zijn opgeslagen in de map Afbeeldingen >
Irfanview -> Oefenbestanden. Het is verstandig om op je computer thuis ook een aparte

map aan te maken voor je oefenfoto’s. Deze foto's kun je mee naar huis nemen. Dat kan via
een USB-stick of via wetransfer.com.

¥

Zoeken Iﬂii Oefenbestanden v‘ [ 15 s kg

4’
e B
bomen.jpg casper.jpg Grote kerk hondjes.jpg Vlaamsegaai.jpg
Nijkerk,jpg
Als je wilt weten, welke bestands-
= : typen door IrffanView ondersteund
—— W(_)rden, !(llk dan op het grijze
viegtuigjpg driehoekje achter Bestandstypen.
Besandenaan:|rendes pg v| e Als je Voorbeeld weergeven hebt
B BRI v Amiemi gangevinkt, zie je in één oogopslag
Recentemap: | Afbeeldingen - <C:\Users\algemeen'\Pictures\> v Welke fOtO je gese|ecteerd hebt,
Pl met en_ige informgtie over de foto.
e S = Zodra je dubbelklikt op de
s L gewenste foto, wordt deze
Crot 193 54 KB (202568 Eys) geopend en kan de bewerking
beginnen!
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5 Foto bijsnijden

Je hebt een foto gemaakt waarvan je eigenlijk maar een deel wilt hebben. Dat gaat heel
gemakkelijk door dat gedeelte te selecteren, uit te snijden en als nieuwe foto op te
slaan. Een detail uit een foto halen gaat als volgt:

e Open het bestand Hondjes in de map Oefenbestanden..

# hondjes.jpg - IfanView (Zoom: 1024 x 862) - o X

Bestand Bewerken Afbeelding Opties gave Help

EHESX A BE39/0M QAQesHEXN

1433x1211x24BPP 4/6 71% 197.84KB/4.98MB  2-3-2010/15:37:18

e Druk de linkermuisknop in en sleep de muisaanwijzer over het gebied dat je wilt
uitknippen.

e Zodra je de aanwijzer begint te verplaatsen, wordt bovenin de balk waar de naam van de
foto staat, het formaat van het kader in pixels aangegeven. Dit is handig als je de foto
een bepaald formaat wilt geven, bijvoorbeeld 800x600 pixels.

e Laatde linkermuisknop los. o —
Je ziet dat er een rechthoek —|ens ceocien suting ot v
om het gebied wordt
geplaatst.

e Ben je niet helemaal
tevreden over de selectie,
ga dan over een van de
lijnen van die rechthoek. De
aanwijzer verandert in twee
pijltjes als je op een van de
lijnen staat.

e Houd de linkermuisknop
ingedrukt; dan kun je die lijn
verslepen waardoor de
rechthoek groter of kleiner
wordt. Op die manier kun je
de precieze uitsnede
bepalen.
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e Je kunt het kader ook . e e
verplaatsen. Klik hiervoor S - ReevLlsd
met de rechtermuisknop : v
binnen het kader. Houd de
rechtermuisknop ingedrukt
en sleep het kader naar de
gewenste plaats. Laat de
rechtermuisknop los.

e Ben je tevreden met de
uitsnede, klik dan op
Bewerken > Selectie
uitsnijden.

Hiernaast zie je het
resultaat.

Om de uitgesneden foto op te slaan (waarbij de originele foto bewaard blijft) ga je naar
Bestand > Opslaan als. Selecteer de map waarin de bijgewerkte foto moet komen en
geef er een duidelijke naam aan, bijvoorbeeld Hondjes-uitgesneden.

Naast Bewerken > Selectie uitsnijden bestaat er ook de mogelijkheid om Bewerken >
Knippen - selectie en Bewerken > Knippen Behoud selectie. Probeer de
verschillende mogelijkheden en kijk wat er gebeurt.

Wanneer je bijvoorbeeld wilt weten of de selectie die je hebt gemaakt kwalitatief goed is,
dan kun je het geselecteerde gedeelte uitvergroten. Als je de selectie gemaakt hebt,
plaats je de muis in het geselecteerde gebied. Er verschijnt een vergrootglaasje met
daarin het plus teken (+). Klik met de linkermuisknop en de selectie wordt vergroot. Om
weer terug te gaan naar de vorige weergave klik je in de werkbalk op het pijltje bij
percentage en zet dat terug op 100%.
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6 Foto draaien

Soms wordt een rechtopstaande foto, zoals een portret, liggend weergegeven. Dit kun je
veranderen door de foto te draaien.

e Open de afbeelding Casper

M casperjpg - IfanVie - O

Bestand Bewerken Afbeelding Opties Weergave Help

EH@XIO.L%E@\OQQ«»@ DX

768x700x24BPP  2/6 100% 12043KB/1.54MB 2-3-2010/15:37:18

e Kilik in de menubalk op Afbeelding. In het menu dat opent staat de optie 'Linksom
roteren' en de optie 'Rechtsom roteren'.

*

Bestand Bewerken | Afbeelding | Opties  Weergave Help

E H @ Informatie I

Mieuwe (lege) afbeelding... Shift+M
Panorama-afbeelding maken...

Linksom roteren L
Rechtsorm roteren R
Aangepast roteren... Ctrl+L
Verticaal omklappen W
Horizontaal omklappen H

e Kilik op de gewenste optie om de foto een kwartslag naar links of naar rechts
te laten draaien.
Je kunt deze stap zo vaak herhalen als je wilt, de foto wordt elke keer een kwartslag
gedraaid.
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7 Grootte wijzigen

Je kunt een foto verkleinen of vergroten tot elk gewenst formaat.
Let op: bij vergroten kan de kwaliteit minder worden!

e Open een foto of — als de gedraaide foto van Casper nog op je scherm staat — ga
door met deze foto.

e Selecteer uit het menu Grovtte/resample afbeelding "
Afbee|d|ng > GFOOtte Enkele standaard afmetingen (pixels):
wijzigen. Standaard staat Huidige grootte: 700 x 768 Pxels Nieuwe groott | (m.g.v. sspectratio optie)
de grootte aangegeven in B O 640 480 Pixels
pixelsl (0 800 x 600 Pixels
Onder 'Nieuwe grootte' kun | "= O 10241768 Pl

[ ]

(D) 1920 x 1080 Pixels
H . 700 . |768
je het formaat aangegeven | #=* Hoogte: [768 | O Aangepast aan bureaublad
in piXG|S Wijzigen in cm of Eenheid: @piels Ocm O inches (O Bureaublad grootte (niet proportioneel)
InCh_eS door Je keuze aan (O Niguwe grootte als percentage van het origineel: Halveren Verdubbelen
toepvpl?xkeelgliteerl?usr;;;]ﬁt OOk Breedte: | 100.00 | % Hoogte: 100.00 % Verwissel zijdes Als standaard toev.

e Vul bij '‘Breedte’ de Aanpassingsmode: »

te b dte i f bii ] Aspectratio behouden (proportionsel) (®) Resample {betere qualiteit). Fiter:
Igewensle reedate In or oij [ Verscheren na Resample P — -
HOOgte. de geWGnSte [ DPI gebaseerd op de nieuwe grootte (asp. ratio) () Replicatie (eneller)
t]/olog}"e In. d b dt f d DPI: (voor auto. em/inches berekening)  [V] Gebmiik een snel Resample fitter bij verkleining
ul-afleen de bree .e 0 e [] Probeer gamma aan te passen bij Resample
hoogte van de foto in, de o —
andere zijde wordt e

automatisch berekend.

e Zorg dat onderaan het scherm Aspectratio behouden (proportioneel) staat
aangevinkt. Daardoor blijven de verhoudingen van de foto ongewijzigd.

o Kilik op OK.

Oefening: Wijzig de grootte van de foto van Casper.

8 Foto opslaan

Ben je klaar met het bewerken van de foto, dan komt de vraag hoe je deze het beste

kunt opslaan. Hiervoor zijn diverse mogelijkheden:

o Klik op Bestand > Opslaan (in originele map). De map waarin de originele foto was
opgeslagen, wordt geopend.

e Als je de originele foto wilt vervangen door de bewerkte versie, klik je direct op
Opslaan. Je krijgt dan de vraag of je de originele foto wilt vervangen, klik op Ja.

e Wil je de originele foto bewaren, typ dan achter 'Bestandsnaam' een nieuwe naam en
sla de foto eventueel op in een andere map door te klikken op de map achter
'Opslaan in' en naar de gewenste locatie te bladeren.

e Kilik op Opslaan.

Wanneer je de originele foto wilt bewaren, kun je ook kiezen voor Opslaan als, zoals
beschreven bij ‘Foto uitsnijden’.

Het tabblad ‘Bestand’ heeft meer mogelijkheden; deze worden in het kort besproken in
een bijlage achterin dit cursusboek.
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9 Lijst om een foto maken

Afhankelijk van het doel waarvoor je je foto wilt gebruiken, kan het erg leuk zijn om er
een speciaal effect aan te geven door bijvoorbeeld een rand om je foto te zetten: je
maakt als het ware een fotolijstje om je foto.

e Open de foto van de grote kerk in Nijkerk.

e Kilik op Afbeeldingen > Rand/Lijst toevoegen. Het onderstaande scherm wordt
geopend.

x

Frame style [default names]:

Gray gradient [with inner + outer color] | Preview:
Red gradient [with inner + outer color)
Green gradient [with inner + outer colar]
Blue gradient [with inner + outer colar)
Black. with a white line and dark gray baorder
Black with a gray line and dark gray border
Black with gray barder

Wihite with black inner edge

Flait white

Drark, gradient

Mano gray with inlay

Gray with black inner and outer border

Flain aray

W arm

Cold v

Frame size: Frame colors:

Border-1 [outer] size: pixelz Border-1 [outer) colar: Chooze

Border-2 size: pixels Border-2 color; Chooge
Border-3 size: pixelz Border-3 color Chooze
Border-4 [inner) size: pixels Border-4 [inner] color; Choose
Auto-load default sizes on style change Autodoad default colors on style change

oK Cancel

- Onder 'Frame style' vind je een aantal mogelijkheden om een lijst te kiezen.
Zodra je op een optie klikt, wordt een voorbeeld weergegeven. De diverse randen
of lijsten kunnen een eigen kleur en dikte krijgen.

- Bij ‘Frame size’ wordt aangegeven hoe breed de randen moeten zijn.

- Bij Frame colors’ kun je aangeven welke kleur de randen moeten hebben.

Het aantal randen waaruit een lijst bestaat is weer afhankelijk van het gekozen

frame. Je kunt je hier dus uitleven.

Oefening: Voorzie de foto van de rand ‘Black with a gray line and dark gray border’ en
pas vervolgens de breedte van de diverse randen aan; pas vervolgens de kleuren aan.
Sla de foto met lijst op onder een andere naam.
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10 Foto rechtzetten

Het kan gebeuren dat je een mooie foto hebt, waarbij alles echter net te scheef staat om
een goed beeld te krijgen van de horizon. Je kunt dit aanpassen door de foto met kleine

stapjes te draaien.

e Open de foto van het vliegtuig en klik
op Afbeelding > Aangepast roteren.
Er wordt een klein scherm geopend
waarin de foto twee keer is afgebeeld:
de originele foto en de nieuwe foto,
zodat je direct kunt zien wat er met je
foto gebeurt.

e Om de horizon recht te krijgen, moet
je de foto een aantal graden draaien.
Zet de hoek (Angle) op -4. Weet je
niet hoeveel graden je moet draaien,
dan kun je met pijltjes naast het vakje
omhoog of omlaag gaan, net zover tot
je foto recht staat

e Vink de volgende vakjes aan:

- ‘Use new rotation method’
(Gebruik de nieuwe
rotatiemethode)

- ‘Enable antialiasing’ (Gebruik
antialiasing)

e Links zie je het origineel en rechts het
gevolg van wat je opgegeven hebt.

e Kilik daarna op OK.

Original image

New image

Options:
Angle:
> (between -360.0 - 360.0 degrees)
[[] Keep original image/canvas size
Keep original image as background
[ Use new rotation method (faster for large images without antialiasing)
Enable antialiasing (better quality but slower)
[[] Select "best" old image in the result image (angle: -30 - 90 deg)
Set background color: Ch
(4,8, 24 BPP images) R

oK ' v Cancel

Je foto staat nu wel recht, maar de randen er omheen zijn niet fraai. Je ziet deze heel
duidelijk door de zwarte achtergrondkleur (die kun je naar wens veranderen).

e Snijd de foto uit zodat de *
schuine kanten wegvallen

SEHEGX (\GE9 0™ QQeshi X%

en bewonder het resultaat.

e Sla de foto op onder een
andere naam.

099xT37x 24899 6/6 100% 3768KB/232MB 2-3-2010/1537:26
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11 Rode ogen-reductie

De meeste fototoestellen bieden de mogelijkheid om bij flitsen het effect van rode ogen
te voorkomen. Is dat niet gelukt, of ben je vergeten dit in te stellen, dan kun je dat
achteraf vaak nog aanpassen.

Open de foto Rodeogen.

Selecteer een 00g.

Ga naar Afbeelding > Rode ogen reductie (selectie).

Klik op deze menukeuze; het rode oog verandert van kleur.

e Herhaal dit met het andere o0o0g.
Hieronder zie je het resultaat van de bewerking: links véér en rechts na rode ogen

reductie.

12 Effecten

Wil je je foto een ‘oud’ effect Effecten > Effectenkiezer... CtrleE
geven, er een schilderij van Adobe 86F plug-ins > 30-knop
maken, of er of eenvoudige Kleuren verwisselen > Vervasg
wijze iets anders kunstzinnigs Palet > Relief
mee doen? Olieverf
Onder de menukeuze i
Afbeelding > Effecten vind je sz
een groot aantal mogelijkheden i‘:::’h:
om je foto's te verfraaien. evia
Regendruppels
Open een foto en probeer deze M:m ;: e
opties maar eens uit.
Filter Zandbak... (plug-in)
Filter Factory... K
Fiiters Unlimited...

Het tabblad ‘Afbeelding’ heeft meer mogelijkheden; een aantal hiervan worden in het
kort besproken in een bijlage achterin dit cursusboek.
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13 Panorama-afbeelding maken
Met deze optie kun je foto's aan elkaar plakken, hetzij in de breedte, hetzij onder elkaar.

Open Irfanview en klik op
Afbeelding > Panorama-
afbeelding maken. Het
hiernaast staande scherm
wordt geopend.

Wanneer je ‘Horizontaal’
kiest, komen de foto’s naast
elkaar te staan.

Kies je voor ‘Verticaal’ dan
worden de afbeeldingen
onder elkaar gezet.

Klik op Afbeeldingen
toevoegen; de verkenner
wordt geopend en je kunt
een aantal foto's aanklikken.
De rest van de instellingen
spreken voor zich.

Klik op Panorama Maken,

Richting:

Bron afbeeldingen:

(O) Horizortaal - afbeelding toevoegen aan de rechter kant vorige afbeeldingen.

(® Verticaal - afbeelding toevoegen onder de vorige afbeeldingen

Hirt: Je kan ook panorama’s over meerdere rjen maken met de ‘Owverzichtsblad maken’ optie in het miniaturen venster.

Afbeeldingen toevoegen

AMbeelding verwijderen

Afbeeldingen sorteren

Omhoog

Omlaag

Kleur ruimte:

Voeg ruimte toe tussen de afbeeldingen:

Ruimte: EI pixels {mag ook negatief zijn)

Fanorama Maken

[] Bestandsnaam toevoegen aan afbeelding finker boverhoek, Tekst dialoog opties)

Annuleren

Kiezen

en je nieuwe afbeelding is gereed.
Tevreden? Sla de afbeelding op onder een herkenbare naam.

In dit scherm is ook een Hint opgenomen; deze verdient enige toelichting. Je kunt hiermee
een overzichtsblad van afbeeldingen openen.

Ga naar het tabblad Bestand > Miniaturen.
Er wordt een scherm geopend waarmee je naar de juiste map kunt navigeren en je foto's
aanklikken die je hebben wilt. In onderstaand voorbeeld zie je een map aangeklikt met

Oefenbestanden.
=]
Bestand Opties Weergave Stop Sluiten

C:\Andreseniorweb\CursussentFotobewerking voor beginners\Defenbestandent
i hp o :
(1 Hp-printer >i| #
-1 Mijam
-1 onderhoud
[_] Operatingsystem
(] PC-Active
(1 Planten
Ll1pp
-1 Programma
..... 1 puzzel
1 Recepten
(1 Samsung Truus
—-[_1 seniorweb
(1 Algemeen
(1 Beleid
(1 Bestuursmededelingen
+[_] Boeken
-1 Cursussen
(2] Adobe
w1 Albelli
+-[_1 Android
(1 App mail
(1 Bestandsheheer
(] Edge
(1 Eenvoudig tekstverwerken
(] e-health
(] Bxcel

— 1 Fotobewerking voor beginners

[_1 Gezondheid

(1 Gmail

+-[_] iCare

[_1 Internetbankieren Rabo
(1 iPad

(1 irfranview

(1 Online gegevens bewaren
-] PhotoFiltre 7

-] Picasa

4[] Powerpoint

bomen,jpg

»

Vlaamsegaaijpg

casper.jpg

i ’

Grote kerk
Nijkerkjpg

hondjes.jpg

u -
o ‘

viiegtuigjpg

rodeogen,jpg
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Selecteer de gewenste foto's en klik op Bestand > Maak een overzichtsblad met de
geselecteerde miniaturen. Onderstaand scherm wordt geopend. De mogelijke
instellingen spreken voor zich. Ook hiermee kun je weer naar hartenlust experimenteren.

Blad grootte: Kleur/ Tekst opties:
®pixels Bladldeur: Kiezen

Breedte: (1024 | Hoogte: Cem
Erkele standaard afmetingen: (Dinches [] Bestandsinformatie wesrgeven

A3 DP: SF |

Ad (® Staand Hint: $F = bestandsnaam, $5 = grootte... . H;Ip

Letter (O Liggend Koptekst:
Afbeelding parameters: |
Kolommen: Rijen: (in images) Vosttelst:
{Kolommen x Rijen = Aantal afbeeldingen per blad) |SM |
[ Kleine afbeeldingen uitrekken tot maximale grootte Lettertype: - Courer New. Size: 10 Kiezen
Tussenmimte: Uitvoer
Horizontaal: Verticaal: {in pieels) (®) Allzen eerste pagina
Marges: () Ale pagina's afdrkdeen
Al ina’ laan:
Horizontaal: Verticaal: {in pieels) CN) SRR lops =2
@am: Sheet HEE
Map: C\Usershalgemeen'App DatatLocal\ Temp'.
Mazk Annuleren :
Opslaan als: | JPG - JPGAIPEG Format

Tip: Om een beter resultaat te krijgen en de foto's precies in elkaar te laten overlopen kun je
het beste van tevoren (dus voordat je ze samenvoegt) de losse foto's al wat bijsnijden.
Je kunt met de muis stukjes selecteren die je wilt wegknippen en dan kiezen voor Bewerken

> Knippen - selectie of Bewerken > Knippen - behoud selectie.

14 Tekst toevoegen

Foto’s zijn ook leuk om te gebruiken voor wenskaarten, en dan is het handig als je je eigen

tekst erop kunt zetten. Ook dat is mogelijk in
dit programma.

e Open in IrfanView een willekeurige foto.

e Maak eerst een tekstvak op de plek waar
de tekst moet komen en klik op Bewerken
> Tekst toevoegen. Het hiernaast
afgebeelde scherm wordt geopend.

e Typ je tekst in het grote lege vak.

e Vervolgens kun je diverse opties op je
tekst toepassen: ander lettertype, grootte
van de letter, omtrek, schaduw, kleur,
transparantie van het vak enzovoort.

e Kilik op Voorbeeld wanneer je het resultaat
van je acties even wilt zien.

e Ben je tevreden, klik dan op OK.
e Sla je foto op onder een andere naam.

Let op: wanneer je op OK hebt geklikt, kun je
de tekst niet meer aanpassen. Wil je toch iets
veranderen, dan moet je opnieuw beginnen!

¥Loord.: 55 Breedte: 278 Beginhoek: Linksboven Rechtsboven
(groepsmode] Midde

Y-Coord.: 43 Hoogte: 35 oo

Linksonder Rechtsonder
Tekst:
Dit is de mooiste toren van Nederdand Copyright toevoegen

Datum toevoegen
Tijd toevoegen

Hirt: 8D = bestandsmap; $F = bestandsnaam ... Help EXIF datum.tiid toev.

Achtergr. transparartie: () Geen () Semitransp. (®) Transparant

£E1 acniergronaskleur

Maak de achtegrondskleur breedte gelilk aan de tekst breedte.
Tekst transparartie: (@) Geen (C) Semitransp. () Transparant
Antialiastekst [ |Omtrek 1 [ Shaduw

Old English Text MT, Size: 14

Omtrek 2 Religf

Lettertype Kleur
Comigeer de lettergrootte met het huidige zoom niveau (indien zoom < 100%)

Tekst uitlijning: @ Links () Midden (O Rechts

Profielen:

| 7] Dso

Venstermode hints:
- De selectie wordt gebruikt indien zichtbaar.
- Klikk op het hoofdscherm als er geen selectie is, voor de tekstpositie en een voorbeeld.

Laden Verwijderen Opslaan

Voorbeeld oK Annuleren

SeniorWeb Nijkerk — 2017-1
Fotobewerking voor beginners

Pagina 19 van 36




In het begin van dit boek is beschreven hoe je diverse plug-ins bij het programma
kunt downloaden. Als de plug-ins geladen zijn, kun je ook een extra werkbalk
openen met diverse mogelijkheden om tekst te bewerken. Ga hiervoor naar

Bewerken ->tekendialoog tonen.

Er wordt een verticale kolom geopend zoals rechts weergegeven.

Ook hiervan kun je gebruik maken om een tekst aan je foto toe te voegen.

e Kilik op het teksticoon (A). Er verschijnt een letter A met een + eronder. Klik op
de plaats waar je tekst moet komen en onderstaand scherm komt in beeld.

Grootte:
v| |18

Maam Lettertype:
| Arial

‘Bl U A

&

De mooiste toren van Nederland

Weergeven als

(®) Niet opgevuld (") Mormale Tekst

() Tekst Opgevuld

K Annuleren

() Antialias Tekst

Testen

e Typ de tekst in het witte viak.

ek'Rwso~NBD~»
@ JFN0N PR

o]
(=]
(]
7

L3

[y
=]
4

amy | =
30 =

Yullen

: |

e Ook hierbij kun je de tekst naar wens aanpassen, maar in dit geval moet je de tekst in het
vlak eerst selecteren, anders worden de aanpassingen niet doorgevoerd!

e Selecteer de tekst, kies lettertype, lettergrootte e.d.

o Je kunt je tekst ook een andere kleur geven, mits bij ‘Weergeven
als’ een van de opties ‘Normale Tekst’' of ‘Antialias Tekst’ is

aangevinkt. In dat geval wordt het kleurenpalet zichtbaar in de

werkbalk (het meest rechtse icoontje).

e Wanneer ‘Niet opgevuld’ of ‘Tekst opgevuld’ is aangevinkt, ziet het

icoontje rechts er anders uit:

¢ Wanneer je nu op het laatste icoon klikt,
komt het hiernaast afgebeelde
vervolgmenu tevoorschijn. Daarin kun je
weer van alles instellen. Gewoon

proberen. Lijntype: Lijneinde: Opgevuld @Ong\.a'uld
e Ben je klaar: klik op OK en je bent weer g— g:'m:_ i ghu;m?ntjin
‘n hat aareta talketerbharmm 0 | e mmeem 02kIg erticaa
ter_u_g in het eerst_e tekstsche_rm. oo O viak o Fecorg (O fremrvard)

e Wil je weten hoe je tekst eruit komt te ol — inksnaar )
zien, houd dan de knop Testen even O .. .. ®rond Kruisgenizze )+ (Loodrecht)
mgedrukt. . () schuin areering () x (Diagonaal)

e |s alles naar wens? Klik dan weer op OK O Recht cevr |
en je tekst staat op de foto. b

Stiftdikte Tweede kleur voor arcering

e Sla je foto op onder een andere naam.

Let op: Ook bij deze vorm van tekst
toevoegen geldt dat na klikken op de laatste
OK, je de tekst niet meer kunt aanpassen.

)

&

Voorgrond  Achtergrond

Pen

10 =] Pixel (1-9399)

r

OK

Annuleren

Penseel

OTransparant @ -

Klik op het voorbeeld venster om de
Voor- en Achtergrondinstelingen om te

=

h |
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Zoals je ziet, kan er heel wat ingesteld worden!

Als je meer wilt weten over dit onderwerp, dan er is een duidelijk Helpfile. Helaas is deze
alleen in het Engels beschikbaar.

Klik in de menubalk op Help > Irfanview... en er komt een uitgebreid helpprogramma in
beeld. In het hieronder opgenomen voorbeeld is de helpinformatie voor het toevoegen van
tekst aangeklikt op het tabblad ‘Inhoudsopgave’: Edit Menu > Insert tekst.

E? IfanView Help - version 4.44

e &=
Verbergen Vorige
Inhoudsopgave  |ndex Zoek 4 |*

& Dverview
@ File Menu
= ([ Edit Meru

E Undo - Redo

2] Paint dialog

E Create custom crop sele
2] Create maximized selec!
E taximize and center se
2] Shiow selection grid

2] Show fiwed grid

il inzert text

2] Insert overlay/watermar
2] Remove/lnsert stip

2] Cut

E Crop

(2] Copy

E Paste

E Delete [Clear dizplay)

@ Image Menu

@ Options Meru

@ View Menu

@ Help Menu

@ Thumbnails

@ Available Hotkeys

@ Find newest |ifariview versi
@ Frequently Asked Cuestions

E Clear Clipboard

Startpagina  Afdrukheen

&

Opties

Insert text Top Previous Mext

You can start the dialog and place the text using mouse click into image or you can use the
left mouse button to gutline the area (selection) on the image where you want text to appear.

How to make a selection? Just press the left mouse button and move the mouse. You will
see the selection rectangle. If you click on the image again outside the selection, the
selection rectangle will be deleted and the selection is no more active.

Click the Edit Menu, then Insert text A dialog box will open.

If this feature is used in the Batch mode (Batch dialog, Advanced options, Add overlay text),
the fields for coordinates are enabled and you can set the start comer and size of the
rectangle which will be used for text.

In the Text box on the left, type in the text you want to put on the image.

Use the Choose Font button to change the size, style, color, etc. of the text. The name of
the selected font is shown below the text box.

If the displayed image is zoomed-in (zoom size < 100%) you can use the option Adjust font
size to current zoom size to make the text "correct” for the current display/zoom.
Example: the current image zoom size is 66%, the selected font size is 12 points. If the
adjust option is used, the inserted font size will be 18 points (=font x 100/zoom), which look
like 12 points in the current zoom.

Uncheck the Background is transparent box to choose a background color. The
highlighted area will change to that color, with the text inside. The small box |eft the button
shows the selected background color.

The dialog offers several combinations of colors and effects, feel free to play with the
combinations.

You can save the current/visible dialog values as a profile and later usefload the saved
values.

Click the OK button to add the text to your image. To close the dialog without adding any
text, click the Cancel button.

Add text may be reversed with the Edit Menu's Undo command.

Hint: If you use SHIFT key + click into image (main window), the color from the image will
be set as text color.

En natuurlijk kun je de Help ook voor andere toepassingen binnen IrfanView gebruiken!

De plug-in ‘Tekendialoog’ biedt nog veel meer mogelijkheden voor bewerkingen; de
diverse gereedschappen worden in het kort besproken in een bijlage achterin dit
cursusboek, waarbij ook enkele oefeningen zijn opgenomen.
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15 Diavoorstelling

Binnen IrfanView is het ook mogelijk om een diavoorstelling te maken. Dat gaat heel
eenvoudig.

e Open een willekeurige foto. e
; ; ; ; ; Bestand Bewerk
o Kilik dan op het tweede icoon in de knoppenbalk, dat is het icoon van
e Het volgende scherm wordt geopend.
estand  Bewerken Afbeelding Opties Weergave Help
M Dizvoorstelling -
Volgende dis Ay
st E
@ utomstischns (5000 fsscondes Speel disvoorsteling © = -
(O Automatisch na muis toets aanslag Naam Gewijzigd op Type Grootte
(O Wilskewigna  [5.000 |secondes Sten AdwCleaner 30-12-201521:15 Bestandsmap
O T Andre T7-12-20162335  Bestandsmap
Andre en Truus 16620150248 Bestondsmap
Diavoorsteling opties ESD 15-6-2016 17:25 Bestandsmap
Begin met afbeckding of dubbekii) A Toon tekt Gebruikers 27-9-2016 23:37 Bestandsmap
] Bestands index orthouden b afsliten SDSF 58X inetpub 28-9-2016 00:11 Bestandsmap
10kit 211120132105 Bestandsmap
Pertlogs 16720161347 Bestondsmap
Pragram Files 20-12-20160959  Bestandsmap
Program Files (x36) 27520122107 Bestandsmap
swsetup 9-12-201516:59  Bestandsmap
Truus 12720160832 Bestandsmap
Windows 27-7-201009:35  Bestandsmap
[ JHerhasl vosrsteling S
Onderchuk fouten tidens voorsteling
Bestandsiypen: | Standaard grafische bestandsn ~
]
Hoasl WP (e achegrond muzek] L ‘
] Verberg muisaanwizer $F =bestandsnaam Help
$X=map index
[ Sluit IfanView af na |aatste bestand $Ex = EXIF, $k = IPTC. D Toevoegen Verwider Omhoog
e Al A o on s
@ Voledige schem (huidige moritor) O in venster afspelen (0) ST REamceT [ =
Volledige schem agtics Xpos 0| Ypos
Breedte Hoogle
[ Gecertreerd

Laad bestandsnamen uit TXT bestand
Bestandsnamen in TXT bestand opslaan
Diavoorstelling als EXE/SCR opslaan
Preview image
Diavoorsteling op CD branden
[ Inclusief submappen {Alles toev.)
[ Toan voor wheeld

e Nu moet je de foto’s opgeven die je op wilt nemen in de diavoorstelling.
o Ga daarvoor via Zoeken in naar de juiste map en selecteer de benodigde foto's.

Zoeken in:] Oefenbestanden VI @ 5 il Gl

bomen.jpg casper.jpg Grote kerk hondjes.jpg rodeogen.jpg
Nijkerk.,jpg

e

Vlaamsegaai.jpg vliegtuig.jpg

Bestandsnaam: I'bomen jpg" "casperjpg" "Grote kerk Nijkerk jpg" "hondjes jpg" "rodeogen jpg" ""Viaamse(

Bestandstypen: | Alle bestanden (*.7) ixd
Dia bestariden Toevoegen Verwijder Omhoog
(0) Alles toevoegen  Alles verwiideren Omlaag Sorteer

e Kilik daarna op Toevoegen.
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De geselecteerde bestanden worden opgenomen in de lijst rechts onder.

Toevoegen Omhoog
Alles toevoegen  Alles verwijderen Omiaag

Pia bestanden s

(7)

Sorteer

C:\Andre\seniorweb\Cursussen\Fotobewerking voor beginners\Oefenbestanden\bomen jpg
C:\Andre\senionweb\Cursussen\Fotobewerking voor beginners\Oefenbestanden\casper jpg
[C:\Andre\senionweb\Cursussen\Fotobewerking voor beginners\Oefenbestanden\Grote kerk Nikerk jpg
C:\Andre\seniorweb'\Cursussen'\Fotobewerking voor beginners\Oefenbestanden\hondies jpg
C:\Andre\seniorweb\Cursussen\Fotobewerking voor beginners\Oefenbestanden'\rodeogen jpg
C:\Andre\seniorweb\Cursussen\Fotobewerking voor beginners\Oefenbestanden\Viaamsegaai jpg
C:\Andre\seniorweb\Cursussen\Fotobewerking voor beginners\Oefenbestanden\viiegtuig jpg

Het is ook mogelijk om je diavoorstelling te ondersteunen met muziek.

Ga weer naar Zoeken in en ga naar
de map waarin je muziekbestanden
staan.

Let op: Zie je wel een map, maar krijg
Je de melding ‘Geen zoekresultaten’?
Kijk dan wat er bij ‘Bestandstypen’
staat. Waarschijnlijk is dat ‘Standaard
grafische bestanden’. Klik op het pijltie
en kies vervolgens ‘Alle bestanden
(*.*). Dan komen de muziekbestanden
in beeld.

Selecteer een muziekbestand en klik
op ‘Toevoegen’. Het bestand wordt
onderaan de lijst met foto’s gezet.
Selecteer het muziekbestand en klik
net zolang op de knop omhoog, tot het
als eerste in de lijst staat.

Als je op zeker moment een ander
stukje muziek wilt horen, dan kun je

|®| Hij is 20 em.mp3

<

Hij is 20 cm

Meewerkende arti...
Andre Hazes
Andre Hazes
Andre Hazes
Andre Hazes
Andre Hazes
Andre Hazes
André Hazes
Andre Hazes
Andre Hazes
Andre Hazes
Andre Hazes

Andre Hazes

Zoeken in | Andre hazes v‘ e =mE-
Naam Nu.. Titel

[ Amor amar.mp3 Fl Amor amor

|&] Artiest.mp3 14 Artiest

|®| Bloed zweet en tranen... & Bloed zwet en tranen

|&] Buena sera.mp3 1 Buena sera

|®] De glimlach van een ki... 10 De glimlach van een kind
&) De viieger.mp3 13 Devlieger

&) Diep In Mijn Hart.mp3 Diep In Mijn Hart

|®| Een beetje verliefd.mp3 10 Een beetje verliefd

|&] Een kijk in je leven.mp3 12 Een kijk in je leven

|®] Een vriend.mp3 ] Een vriend

|&) Geef mijjeangstmp3 14 Geef mij nu je angst

| Het is zo donker om je ... 9 Het is zo donker om je he...

Andre Hazes

Album ®

Hello Summer Time

mega party volume
Unknown Album
Voor mij vrienden ce

Bestandsniaam |

iia bestanden

Toevoegen

Bestandstypen: | Alle bestanden (")

(8) Alles toevoegen | Alles verwideren

Werwiider Omhoog

Omlazg

C:\Users\algemeen'\Music\music'\Andre hazes\Artiest mp 3
“Andre'seniorweb*Cursussen\Fotobewerking voor beginners'Oefenbestanden‘bomen jpg
“\Andre\seniorweb “Cursussen\Fotobewerking voor beginners\Oefenbestanden‘casper.jpg
\Andre“seniorweb\Cursussen \Fotobewerking voor beginners\Oefenbestanden\Grote kerk Nijkerk jpg
“Andre'\seniorweb \Cursussen\Fotobewerking voor beginners'Oefenbestanden‘hondies jpg
“\Andre\seniorweb ‘Cursussen\Fotobewerking voor beginners\Oefenbestanden‘rodeogen jpg
\Andre“seniorweb\Cursussen \Fotobewerking voor beginners'\Oefenbestanden'\Wlaamsegaai jpg
“Andre'seniorweb \Cursussen\Fotobewerking voor beginners'Oefenbestandenwliegtuig jpg

Sorteer

dat aangeven door op de juiste plaats een ander muziekbestand te plaatsen.
Loop alle instellingen nog eens na en klik dan op Speel diavoorstelling.

Als de
diavoorstelling
naar je zin is, dan
kun je deze als
executable
opslaan. dat wil
zeggen dat je die
daarna zonder
IrfanView kunt
afspelen. Klik
hiervoor op

instelingen gemaalkt.

(Opties:

Resultaat in bestemmingsmap opslaan:

(®) Maak EXE file (los staande diavoorsteling, " exe’)

() Maak SCR bestand (Schermbeveiliging., "scr)

De diavoorstelings EXE/SCR wordt met uw huidige DiavoorstellingVaolledig Schem

Diavoorstelling

|C:"-_-‘1'-ndre"-seniu:urwel:u"-.Cursussen"-.FDtDI:uewerking voor beginners®, |

als EXC/SRC
opslaan. Het

Resultaat bestandsnaam (comecte extensie wordt automatisch toegevoegd):

scherm hiernaast

||"-"Iijn eerste voorsteling

wordt geopend:

Maak

Annuleren

Bladeren
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e Kies Maak EXE file en geef aan waar het resultaat moet komen en welke naam je
diavoorstelling moet krijgen.

e Klik op Maak. Je krijgt een melding (in onderstaand voorbeeld is het kennelijk goed
gegaan, want er staat 0 fouten/waarschuwingen):

IrfanView >

Klaar met bewerking!

0 fouten/waarschuwingen.
Zie helpbestand voor informatie over fouten/waarschuwingen.

QK

e Nu kun je het resultaat mailen of op een usb-pen zetten.

Let op: niet alle instellingen worden in deze cursus behandeld; maak eens een
proefvoorstelling en loop zelf alle mogelijkheden na. Klik bijvoorbeeld op ‘Volledige scherm
opties’. Je zult zien dat je dan nog meer kunt doen met je project!
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Bijlage 1. Meer opties tabblad Bestand

Het tabblad Bestand geeft diverse mogelijkheden, waarvan de meeste voor zich
spreken. Een aantal ervan is tijdens de cursus behandeld. Hieronder een beknopt
overzicht van enkele handige opties..

J Es hondjes.jpg - IfanView

Bestand Bewerken Afbeelding Opties Weergave Help

Openen.., 0
Heropenen Shift+R
Open recente bestanden >
Open met externe bewerker >
Openen als >
Miniaturen.., T
Diavoorstelling... w
Diavoorstelling met de huidige bestandslyjst Ctrle W
Groepsconversie/Hemoemen... B
‘Bestanden zoeken... CtrleF
Bestandsnaam wigzigen... F2
Bestand verplaatsen... F7
Bestand kopiéren... F8
Bestand verwijderen... Del
Opslaan (in onginele map) CurlsS
Opslaan als... s
Opslaan voor het web... (plug-in)

Selectie opslaan als tri+ Shift+B
Afdrukken... Ctrl+P
Scannerbron selecteren...

Scannen/Groepscanned... Ctrls Shift+ A
Copyshop...

Sluiten Esc

Het eerste blok in het menu slaat op het
openen van bestanden. Het kan geen kwaad
om de diverse manieren van openen aan te
klikken en eventueel uit te proberen. Je kunt
altijd weer ongewijzigd afsluiten.

Miniaturen

Deze optie opent de Verkenner en laat de
afbeeldingen in miniatuurvorm zien (zie
afbeelding onderaan deze pagina).

Bestandsnaam

De keuzen in het met rood aangegeven deel
hebben betrekking de bestanden op de harde
schijf. Dus als je hier Bestand verwijderen
kiest, dan wordt het bestand van de harde
schijf naar de Prullenbak verplaatst.

Bij voorkeur deze opties hier niet gebruiken,
maar dit soort acties uitvoeren met de
Verkenner.

Bestand Opties Weergave Stop Sluiten

C:\Andrehseniorweb\Cursussen'\Fotobewerking voor beginners\Oefenbestanden’s

~-[_] seniorweb
(+-[_] Algemeen

..... [_] Bestuursmededelingen
(+-[_] Boeken

(=-[_] Cursussen

(] Adobe

-0 Albeli

(+-[_] Android

(+-[_] Bestandsbeheer
(+-_] Edge

A

Vlaamsegaai.jpg

.’_

hondjes.jpg

Grote kerk
Nijkerk,jpg

rodeogen.jpg

vliegtuig.jpg

Voorbeeld van Verkenner met miniaturen (geopend in IrfanView).
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Bestanden zoeken
Wil je in IrfanView

. Bestanden zoeken *
iets doen met een
bepaalde foto, maar Bestandspatroon: Zoeken starten
weet je niet meer [ | :

.
precies waar deze Zoeken in:
staat? Met deze |C:\Pﬂdre\seniomeb\Cursussen\Fntobewedﬂng woar beginners\(| Bladeren...

optie kun je snel het [] Submappen doorzoeken
juiste bestand
zoeken, zonder dat
je hiervoor naar de
Verkenner gaat.

[] Datum tussen: en |03-01-2017 {dd-MMjiii}
Zoek tekst in bestand:

[ Kijke in IPTC data  {IPTC plug+n nedia)
[ Kijkc in EXIF data  (EXIF plug-n nodig)
[ Kk in Kommentaar data

Zoekresultaat:

C:\Andre'\seniorwebCursussen’\Fotobewerking voor beginners®\Oefenbestanden’bon| | Sodeer bestanden
C:hAndre seniorweb CursussenFotobewerking voor beginners"\Defenbestanden'cas)
C:M\Andre \seniorweb CursussenFotobewerking voor beginners\DefenbestandenGro|
C:M\Andre \seniorweb Cursussen’Fotobewerking voor beginners\Defenbestandenhon
C:hAndre seniorweb CursussenFotobewerking voor beginners\Defenbestandenrods Verwiider Uit -
C:hAndre seniorweb CursussenFotobewerking voor beginners"\Defenbestanden'Wa: Erwijder Uit resuita

C:hAndre seniorweb CursussenFotobewerking voor beginners\Defenbestandenwlies

3

Gebruik alleen
0 gezelecteerde

bestanden bij

"weergave”.

In hoofdschem
Valledig schem
Miniatuurweergave
[7 bestanden
Daarnaast bestaat .
&8 casperjpg (T00x768 px @ 24bit JPEG image) - RIOT - O X

er nog de Optle File Edit View Tools Help
Opslaan voor het o~ =
web. Dat kan echter ODL/ g Q
alleen als je de

Plug-ins
gedownload hebt

9.8 2

About My Business

Initial image 123.318 bytes (120,42 KiB)

(zie het hoofdstuk @
Plug-ins). In dat ?
geval krijg je het @
scherm als =
hiernaast.

Als je een foto
opslaat voor het

Web, dan wordt de GF @@PNG

grootte van de foto

verkleind. aury [ .

Ook hler kun Je Chroma subsampling | Medium (4:2:0) V! [ Progressive
[[] Grayscale

weer het een en
ander instellen, FPEG Options

- - Rea: Optimized: 24bit JPEG image
zoals de kwaliteit. & et LR
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Bijlage 2: Meer opties tabblad Afbeelding

Ook het tabblad Afbeelding geeft diverse mogelijkheden, waarvan de meeste voor zich
spreken. Een aantal ervan is tijdens de cursus behandeld. Hieronder een beknopt
overzicht van enkele handige opties..

Informatie I
Mieuwe (lege) afbeelding. . Shift+N
Panorama-afbeelding maken..,

Linksem roteren L
Rechtsom roteren R
Aangepast roteren... Ctrl=U
Verticaal omkdappen L)
Herizontaal omklappen H
Grootte wijzigen... Ctrl+R
Canvasgrootte.., Shift+ ¥
Rand/Lijst toevoegen... Ctrl=D

Eleurendiepte vergroten...

Eleurendhepte verkleinen...

Converteren naar grijstinten Ctrl+ G
Kleurkanaal tonen ke
Kleurennegatief »
Kleuren aanpassen... Shift+G
Histogram... Shift+H

Kleur vervangen...
Getegelde afbeelding maken...

Automatische kleurenaanpassing Shift+L
Verscherpen Shift+3
Rode ogen reductie (selectie] Shift+Y
Effecten ¥
Adobe BBF plug-ins »
Kleuren verwisselen *
Palet ¥

Kleuren aanpassen

Geeft een keuzescherm waarin
o.a. helderheid, contrast en
andere kleurenopties kunnen
worden aangepast. Links zie je
de originele afbeelding, rechts de
nieuwe afbeelding.

Steeds wanneer je iets verandert,
zie je dat op de rechter foto.

Als je het nieuwe resultaat beter
vindt dan het origineel, dan kun
je OK aanklikken.

Let wel op dat je het nieuwe
resultaat moet opslaan,
eventueel (of bij voorkeur) onder
een andere naam.

Informatie.
Geeft informatie over de foto zoals naam en locatie
van het bestand, technische informatie, e.d.

Verticaal en Horizontaal omklappen.
Hiermee wordt de foto op zijn kop gezet (verticaal) of
gespiegeld (horizontaal).

Afbeelding > Converteren naar grijstinten.
Dit spreekt voor zich.

* Kleuren aanpassen

Nieuwe afbeelding

Helderheid: Contrast:

B P ] i P ]
Kleur balans: Gamma comectie:
8 ] —a
G: f E] Verzadiging:
& ] ] 8 o]
Profielen:

v | Toepassen Standaard waardes |
Laden Verwiideren| | Opslaan [[] Waardes bewaren bij het afsluiten

Hint: klik op het origineel {ichte gebieden) om !
de witbalans aan te passen (RGB waardes) OK Annuleren

SeniorWeb Nijkerk —2017-1
Fotobewerking voor beginners

Pagina 27 van 36



Kleur vervangen

Deze optie biedt de mogelijkheid om bepaalde
kleuren aan te passen.

Geef in het eerste deel (Replace source
color:) aan welke kleur je wilt aanpassen en
in het tweede deel (with new color:) de
nieuwe kleur aan.

Geef vervolgens aan bij ‘Tolerance value’
hoeveel tolerantie er gebruikt mag worden.
De hoeveelheid tolerantie geeft aan hoeveel
de kleur mag afwijken van de opgegeven
Kleur.

In de foto van het vliegtuig, eerder gebruikt
om de horizon aan te passen, zie je hieronder
wat de gevolgen zijn van de veranderde
instellingen

Replace Color *

Feplace zource color:
| Chooze
[RGE: 255, 255, 255; Hew: FFFFFF)

with new color:
| Chooze
[RGE: 128, 255, 0; Hex: 80FFO0]

Talerance value: [0-128]

Hirt for window mode:

Left mousze button click into the image [main window] to set
the gource color.

Right mouse button click into the image [main window) to
zet the new colar.

Apply to ariginal image | 0K |

Undo Cancel

Bestand Bewerken Afbeelding Opties Weergave Help

EEESX {2EB92 0™ | RQesT XN

1175x791x24BPP  6/6 100% 37.68KB/2.66 MB 2-3-2010/ 15:37:26

Replace source colr:
Choose
(RGB: 255, 255, 255 Hex: FFFFFF)

with new color:

—

(RGB: 138, 232, 106: Hex: BAEBE4)

Choose

Tolerance value: (0-128)

Hint for window mode:

Left mouse button click inta the image [main window] to set
the source color.

Right mouse button click into the image (main window) to
set the new color.
Apply to original image 0K

Undo
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Getegelde afbeelding maken

Hiermee kun je een foto herhalen.

Open een foto en klik op Afbeelding >
Getegelde afbeelding maken.

Stel bij ‘Method 1: Set number of tiles:’ het
aantal tegels in, bijvoorbeeld 4 naast elkaar
en 4 onder elkaar.

Je kunt tussen de tegels een gekleurde rand
maken. Dit geef je aan bij ‘Set space between
images (pixels)’. Je kunt de breedte opgeven
voor de horizontale en de verticale rand. In
het voorbeeld hierbij is de tussenruimte voor
beide op 5 pixels gezet. Ten slotte kun je bij
‘Space color’ de tussenruimte ook nog een
kleur geven. In dit voorbeeld groen.

En zo heb je van één foto van Caspar er 16
gemaakt....

Create tiled image >
(®) Method 1: Set number of tles:
width: Height: [4 |
(") Methad 2; Set final image dimensions in pixels:
piels
Whdthe 2000 Height: | 1500 crn
Some standard dimenzions: nches
fe DPI: 72
b Partrait
Letter Landscape

Set space between images [pixels]:

Harizontal: "v"ertical: [pirets)

ok,

Chooze

Cancel

M o

Bestand Bewerken Afbeelding Opties Weergave Help

FERGX {2E39/0 JAaQeasi@ XY

2815x3087x24BPP  2/6 28% 12043KB/24.87MB 2-3-2010/15:37:18
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Bijlage 3: De plug-in ‘Tekendialoog’ nader bekeken

Wanneer je de extra plug-ins hebt geinstalleerd, kun je ook gebruik maken van de plug-
in ‘Tekendialoog’. Om deze te starten, klik je op Bewerken -> Tekendialoog tonen.

#¢ bomen.jpg - IfanView (Zoom: 1149 x 862) verf  [EB
Bestand Bewerken Afbeelding Opties Weergave Help Y &
Ongedaan maken Ctrl+Z
g - ') [%
Opnieuw uitvoeren Ctrl+J
A
Tekendialoog tonen F12
= e
Aangepaste selectie maken... Shift+C 0 O
Maxirnale selectie naar ratio: > éﬁ .{f
Selectie maximalizeren en centreren
Selectieraster tonen > @ %
Wast raster tonen P ﬂ
Nu krijg je een aantal mogelijkheden om iets met de afbeelding te doen. Wat al
die verschillende icoontjes betekenen, wordt hieronder regel voor regel, van =
boven naar beneden,beknopt toegelicht. Wanneer wordt gesproken over het 10~
PAINT-menu, wordt het gedeelte onder de streep, vanaf ‘Grootte’ bedoeld.
0 :
Selectiepijl: is bedoeld voor standaard gebruik in IrfanView. bijvoorbeeld om een vullen
selectie te maken of een bereik te markeren. “
Penseel: is bedoeld voor het tekenen uit de vrije hand. Met de linkermuisknop Ii
teken je met de voorgrondkleur en met de rechtermuisknop teken je met de

achtergrondkleur.

Vlakgom: gebruik je om met de hand gedeeltes te wissen. Met de linkermuisknop wis je met
de achtergrondkleur, d.w.z.: waar je het vlakgom gebruikt, wordt de kleur vervangen door de
achtergrondkleur. Bij gebruik van het viakgom met de rechtermuisknop wordt de originele
toestand hersteld.

Kloongereedschap: Hiermee kopieer je een deel van het plaatje naar een andere plek. Zo
kun je bijvoorbeeld makkelijk krassen wegwerken. Klik met de rechtermuisknop op de plek
waar de gewenste kleur vandaan moet komen. Klik met links in het gedeelte waar je iets wilt
wijzigen. Grootte van het kloongebied is in te stellen. Een kruis geeft aan vanaf welke plaats
wordt gekloond.

Kleur wisselen: hiermee vervang je met de linkermuisknop de achtergrondkleur door de
voorgrondkleur. Met de rechtermuisknop vervang je de voorgrondkleur met de
achtergrondkleur. Dit doe je in combinatie met het vlakvulgereedschap.

Tekstgereedschap: hiermee voeg je geformatteerde tekst toe in het plaatje. De plek van het
kruisje wordt de basislijn van de tekst. Het uitlijnen vindt plaats vanaf de plek van het kruisje!
Deze bewerking wordt in hoofdstuk 14 toegelicht.

Met CTRL-Z kan één keer iets ongedaan worden gemaakt.

Lijngereedschap: Hiermee teken je rechte lijnen. Klik en trek de lijn in de gewenste richting.
Laat de muisknop los en de lijn ligt op zijn plaats. Om het tekenen af te breken, druk je op de
rechtermuisknop. Houd de CTRL-toets ingedrukt om de lijn vanuit het startpunt naar
weerzijden te tekenen. Houd de SHIFT-toets ingedrukt om de lijn exact onder hoeken van
45° te maken, d.w.z. dat je lijnen echt recht worden.

Pijlliingereedschap: hiermee teken je pijllijnen. Klik met de rechtermuisknop op het icoon
om het menu te krijgen voor meer opties voor de opmaak van je pijl. Klik en trek de pijllijn in
de gewenste richting. Laat de muisknop los en de pijl ligt op zijn plaats.
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Ellipsgereedschap: Hiermee teken je ellipsen en cirkels. Als in het PAINT-menu onderin
'Vullen' is aangevinkt, wordt de figuur opgevuld met de voorgrondkleur. Klik en trek om de
gewenste vorm en richting van de ellips te maken. Laat los als de gewenste vorm is bereikt.
Om het tekenen af te breken, druk je op de rechtermuisknop. Houd de CTRL-toets ingedrukt
om de ellips vanuit het midden te tekenen. Houd de SHIFT-toets ingedrukt om een cirkel te
maken.

Rechthoekgereedschap: Hiermee teken je vierkanten en rechthoeken. Als in het PAINT-
menu onderin 'Vullen' is aangevinkt wordt de figuur opgevuld met de voorgrondkleur. Klik en
trek om de gewenste vorm en richting van de rechthoek te maken. Laat los als de gewenste
vorm is bereikt. Om het tekenen af te breken druk je op de rechtermuisknop. Houd de CTRL-
toets ingedrukt om de ellips vanuit het midden te tekenen. Houd de SHIFT-toets ingedrukt
om een vierkant te maken.

Vlakvulgereedschap: hiermee kun je vlakken één bepaalde kleur geven. Via de
linkermuisknop vul je met de voorgrondkleur en met de rechtermuisknop vul je met de
achtergrondkleur. In het PAINT-menu onderin kun je de gewenste kleurtolerantie van de
oorspronkelijk kleur instellen.

Kleurpipet: Hiermee maak je de kleur van een gekozen pixel tot actuele voor- of
achtergrondkleur. De linkermuisknop voor de voorgrondkleur, de rechtermuisknop voor de
achtergrondkleur. Tijdens het bewegen van het pipet zie je in het PAINT-menu in een klein
vierkant blokje links onderin de kleur van de pixel onder het pipet. Houd je de SHIFT-toets
ingedrukt dan kies je één keer en vervolgens ga je vanzelf terug naar het eerder gebruikte
gereedschap.

Rotatiegereedschap: Hiermee kun je een afbeelding rechtzetten of draaien. Klik en trek een
lijn waarlangs de afbeelding horizontaal of verticaal moet uitlijnen. Om het tekenen af te
breken druk je op de rechtermuisknop. Houd de CTRL-toets ingedrukt om de lijn vanuit het
midden te tekenen. Houd de SHIFT-toets ingedrukt om de lijn exact onder hoeken van 45° te
maken.

Meetgereedschap: hiermee kun je afstanden en hoeken in de afbeelding meten. Klik en
sleep om de te meten afstand te selecteren. Wanneer je met de rechtermuisknop op het
icoontje Klikt, opent het bijpehorende menu.
Pen en penseelinstellingen:

Via dit menu kun je instellen hoe je de lijnen
wilt hebben. Voo [

Pen- en penseelinstellingen X

. . P P |
Let op: Dit menu bestaat uit twee Lf”w - E:EE o ®omenid
nn =4 qnende;
tabbladen: Voorgrond en Achtergrond. Op R ’ POEIL PaEL
. R .. . (O] (® Rond Rechte () - (Horizontaal)
beide tabbladen kun je allerlei instellingen = arcering _
O {_) Hoekig () || (Verticaal)
aa_npassen'_ A [ - Civlak 452 Arcering () Y\ {neerwaarts)
Klik steeds in het voorbeeld onderin het O . . . | afedtng: ks naar )
menu om te zien wat de gevolgen zijn van O_.. .. | ®rond Kruisgewijze () + {Loodrecht)
je instellingen. 0. () schuin arcering () x (Diagoniaal)
Oresht ces
Stiftdikte Tweede kleur voor arcering

10 { Pixel (1-9999) () Transparant @-

3

_ | Klik op het voorbeeld venster om de
oK Annuleren Voor- en Achtergrondinstelingen om te
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Bijlage 3a: Oefeningen Tekendialoog

Ga nu het een en ander uitproberen. Stel eerst een voorgrond- en een achtergrondkleur in.
Dat doe je onderin de tekendialoog. Daar stel je ook de lijndikte in. Na het tekenen van een
liin gum je die weer weg met het gum, maar wel met de rechtermuisknop.

{ g 5 '
81008 | i
WY e

ONNONP>BY

evwRsSsONED >

@
8
i

W vigtuigipg - Manview
Bestand_Bewerken Afbelding Opties Weergave_Hep

SEHEESX L D@20 Qe DX Y

121865724899 77 100% 37.60KB/290MB 2-3-2010/ 153726
o o

@®@B2om®

De bovenste lijn is met het
liingereedschap gemaakt.
De middelste lijn is met
het pijllijngereedschap
gemaakt waarbij 'Vullen'
niet aangevinkt is, evenals
de onderste lijn, maar
daarbij is het 'Vullen' wel
aangevinkt.

Let op: de pijl komt aan
het einde van de lijn.

Teken twee cirkels en vul
ze op met een
voorgrondkleur en een
achtergrondkleur.

Let op: de randdikte wordt
bepaald door de variabele
'‘Grootte'. Als je geen rand
wilt zien, dan maak je de
voorgrond- en de
achtergrondkleur gelijk.

Open de afbeelding van
het vliegtuig en trek met
het rotatiegereedschap
een lijn evenwijdig aan de
gewenste horizon. Snijd
daarna de foto zodanig uit
dat de groene vlakken
wegvallen.
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Meet de spanwijdte van de
vleugels op met het
| meetgereedschap.

Meetresultaat =

3092 px I oK |
1.34510n
45.89 mm

=uwe eenheid,

Als laatste oefening laat je een tweede vliegtuig (of nog meer) meevliegen; dat doe je met
het kloongereedschap.

Op deze manier kun je met de diverse gereedschappen aan de slag.
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Bijlage 4: Extra opties

Er zijn veel opties in het programma die je conform je eigen voorkeur kunt instellen.

Via Opties -> Eigenschappen/instellingen kom je bij onderstaand scherm. Een van de
dingen die je wellicht wilt aanpassen, is de werkbalk. Hiervoor kun je kiezen uit verschillende
thema's. Standaard staat dit meestal op Grosberg_24. Wanneer je klikt op een van de
andere thema'’s, zie je vanzelf wat er gebeurt. Probeer maar eens een ander thema uit. Pas
wanneer je op OK Kklikt, wordt het thema aangepast. Wil je dat niet, dan kun je de actie
annuleren, of dit scherm afsluiten zonder op OK te klikken.

Eigenschappen/Instellingen *
Start / Afsluiten opties Werkbalk
JPG S PCD / GIF
Extensies
Weergave Selecteer een thema: Toon/verberg werdballkdknoppen:
Zoom / Kleuren managemen A
Bladeren/Bewerken
Volledige Schemn./diavoorste DEFALLT Openen
VideoGeluid lors-h 48 Di retell
Bestandsoperaties gnome-colors-human_: iavoorsteling
Taal gnome-colors-wise_32 [ ] Minigturen
etk & Opslan s
EIES.LHZ Samuel_16 Afdrukken
g Bestand verwijderen
Selectie uitsnijden
Kopigren
Flakken

Ongedaan maken

Afbeelding informatie

Zoombox W

EEEFEESX X 2E90R @@ E.

Annuleren

Informatie over de maker van het thema:

Michael Grosbeng

(Kijlc op  woww ifanview net  voor meer thema's)

Enkele algemene tips

Wanneer je bij een bewerking op de toets Escape (Esc) drukt, wordt niet alleen de handeling
gestopt waar je mee bezig bent, maar sluit je het hele programma af!

Als je per ongeluk dubbelklikt in een afbeelding, dan raak je het lint kwijt. Je ziet alleen je foto
met links bovenaan een tekst. Klik helemaal in het hoekje van je scherm links bovenaan en
het gewone scherm met het lint is weer terug.
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FOTOBEWERKING VOOR BEGINNERS:

MET IRFANVIEW

Zo'n digitale camera maakt het wel heel gemakkelijk om veel foto’s te maken, maar
dan komt de vraag: wat moet ik er nu verder mee?! Hoe bewaar ik ze, hoe kan ik ze
terugvinden, en kan ik er ook nog wat leuks mee doen?!

In dit cursusboek wordt een groot aantal mogelijikheden gegeven om foto’s op
eenvoudige manier te bewerken, met behulp van het programma IrfanView. Het
downloaden en installeren van het programma wordt behandeld. Naast de diverse
gebruikelijke bewerkingen als roteren, bijsnijden en rode ogen verwijderen, wordt ook
aandacht besteed aan het toevoegen van tekst aan een foto, het maken van een
panorama-afbeelding en een diavoorstelling.

Een praktisch cursusboek waarmee je snel de basisbegrippen van fotobewerking
onder de knie kunt krijgen!
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